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Micro Focus COBOL Server 3.0 Release
Notes
These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.
Note:
•

•

This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

COBOL Server provides the execution environment for applications created with any IDE variant of Visual
COBOL.
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| Micro Focus COBOL Server 3.0 Release Notes

What's New
This release provides enhancements in the following areas:
•
•
•
•
•
•

Application Server JCA support for Enterprise Server
Data File Tools
Deployment on multiple platforms
Documentation
Enterprise Server
iFileshare

Application Server JCA support for Enterprise Server
Restriction: This feature applies only when the Enterprise Server feature is enabled.
In this release, EJBGEN has been updated to generate an EAR file as a part of the COBOL deployment
process, which enables you to deploy EJBs to Java Application Server.
Back to Top
Data File Tools
This release provides the following enhancements to Data File Tools:
•

•

•

•
•
•
•

Opening files in shared mode - it is now possible to switch between read-only shared and edit modes.
While a file is open in shared mode, others users can only open it in shared mode to ensure data
consistency between users.
Enterprise Server-level of security when accessing files - there is an improved level of security when
exchanging data between Data File Tools and the targeted enterprise server instance. Users must now
provide a user ID, group and a password when they try to access and view datasets in enterprise server
instances. These are used for authentication and authorization checks to provide the same access level
as Enterprise Server.
Opening datasets using SSL - communication to a region is now possible using SSL. To enable the SSL
communication, you need to provide a Java trust store which contains either a CA root certificate or a
self-signed certificate of the region that it is communicating to. Java and the targeted region SSL
configurations need to meet each other's standards in order for the communication to succeed.
This feature enables you to secure the information exchange between Data File Tools and the targeted
enterprise server.
Auditing of access and updates on datasets - Audit Manager now audits the access and updates on
datasets via Data File Tools.
Support for existing .pro files - enables you to use your existing editor profiles.
Support for existing .str files - enables you to use your existing COBOL structure files.
Automatic timeout - if no internal operations or external actions (such as a mouse click) have been
detected for 30 minutes, Data File Tools now displays a countdown message. If the user does not take
any decision within the specified period, Data File Tools closes all opened files.

Back to Top
Deployment on multiple platforms
This release provides support for deploying JVM COBOL applications on multiple platforms. You can
compile an application on one platform (such as Windows) and then deploy its class files to a different
platform (such as Linux or UNIX).

What's New
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Some features of the COBOL language, however, are platform-specific and their behavior on different
platforms might vary. See Multi-Platform Deployment of JVM COBOL Applications in your product Help for
details.
Back to Top
Documentation
The following new sections have been added to the product help:
•

•

Where do I start? - located on the launch page of the product help, this section provides the information
you need in order to get started depending on which aspects of the product you need to get to grips
with first.
Multi-Platform Deployment of JVM COBOL Applications - includes information about how to ensure the
portability of your JVM COBOL applications between Windows and UNIX or Linux platforms.

Back to Top
Enterprise Server
Improvements are available in the following areas:
Long user IDs and passwords:
•

Enterprise Server now supports user IDs and passwords of up to 100 characters. It is possible to map
IDs from long to short (or vice versa) to enable compatibility with programs that do not support long
names.

SHA-256 support in DemoCA:
•

By default, the Demonstration Certificate Authority (CA) now signs certificates with SHA-256. This
ensures that the demonstration or evaluation certificates will be accepted by modern browsers and
other software that has enhanced security requirements.

Syslog auditing:
•

Enterprise Server now supports auditing using syslog events, which can be consumed by a wide range
of Security Information and Event Management (SIEM) products. This replaces the Audit Manager
auditing solution. Syslog auditing provides a much more efficient auditing mechanism, with significantly
less impact on overall speed.

Back to Top
iFileshare
iFileshare is no longer considered an Early Adopter Program, and contains the following enhancements in
this release:
•

An improved failover and recovery process. iFileshare now supports full recovery of nodes in the group.
For high availability (HA-VSAM) groups, servers can now rejoin the group without the entire group
having to be restarted. In addition:
•
•

•
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A primary failover now results in a takeover from the most suitable node.
If configured, external clients will automatically reconnect to the new primary and will issue a
notification if the transaction has been lost.
• A failed node, when restarted, will rejoin the group, recover its files and request a log update from
the current primary. Once this task has completed it will be considered an active hot-standby and will
continue to process replication requests as normal.
• Users will experience a higher level of uptime/availability with their Fileshare configuration and will be
able to recover from errors more easily.
A new exit procedure, ifsexitproc.cbl, can be configured to automate some aspects of iFileshare
behavior.

•
•

The iFileshare Control page in ESMAC contains details of the current iFileshare high availability group.
The following new iFileshare-specific environment variables are available:
•

•

FSWRKDIR - enables you to specify the Fileshare working directory, overriding the default, which is
the system directory of the region.
• FSCHKLFH - determines if a check is performed when a high availability group is started, to test the
consistency of the data files within the group.
The database reference file (dbase.ref) now supports wildcard matching for filenames, allowing you
to perform operations on multiple files at once; for example: fs /d dbase.ref /f data\* adds the
entire contents of the data directory to the database reference file.

Back to Top

What's New
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.
Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•

Compatibility AddPack
Documentation
Enterprise Server
File Handling
Micro Focus Directory Server
OpenESQL
Reserved words
SQL Option for DB2

Compatibility AddPack for Visual COBOL
Back to the list
Compatibility AddPack for Visual COBOL is now deprecated and will not be available with release 3.0 and
later.
The Dialog System GUI and run-time components and Dialog System Character Mode (on Windows and
UNIX) which were part of the AddPack are now installed as part of Visual COBOL for Visual Studio. The
run-time components are installed as part of COBOL Server. These are only included for backward
compatibility and Micro Focus does not recommend that you use them for new development.
The other components which were part of the AddPack, the Character-Based Data File Editor, CSBIND
and Screens, will be available upon request from Micro Focus SupportLine.
Documentation
Back to the list
•

There have been a number of new reserved words added to the language in this release; these are all
in effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them: ALLOCATE FREE JSON END-JSON

Enterprise Server
Back to the list
•

WEB CONVERSE now supports a value of 0 for the USERLEN and PASSWORDLEN options which
matches the behavior on the mainframe. There is no change to the behavior of WEB SEND (client)
which is to return LENGERR 139/140 when USERLEN or PASSWORDLEN are 0.
2989188 (1108602)

File Handling
Back to the list
•
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Under certain circumstances, retry-lock requests on UNIX systems were sleeping for a second before
re-attempting to acquire the lock. This no longer happens.

| Significant Changes in Behavior or Usage

•

2988222 (1108521)
A problem that generated a 39 error when attempting to access a VSAM file via an alternate index
PATH element has been fixed.
2874622 (1106562)

Micro Focus Directory Server
Back to the list
•

•

In the Enterprise Server Administration HTML GUI, the "Scripts" page functionality is only available if
administration access is restricted and the logged on user has sufficient authority.
3101625 (1109025)
Some additional CSRF security measures have been added to the Enterprise Server Administration
HTML GUI.
3101205 (1108916)

OpenESQL
Back to the list
The new OpenESQL OPTIMIZECURSORS SQL compiler directive option is turned on by default for both
ADO.NET (DBMAN=ADO) and ODBC (DBMAN=ODBC). For ADO.NET, this reduces cursor memory
consumption thereby providing optimal performance. This also ensures that, for ODBC, embedded SQL
cursors that use WITH HOLD and FOR UPDATE clauses have the same data integrity across all
databases.
If your applications require the OpenESQL preprocessor to use the behavior provided in an earlier release,
compile them using OPTIMIZECURSORS=NO.
Reserved words
Back to the list
•

There have been a number of new reserved words added to the COBOL language; these are all in
effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them:
ALLOCATE
FREE
JSON
END-JSON

SQL Option for DB2
Back to the list
•

Help buttons previously available on the XDB Server Configuration Utility, XDB Service Controller,
Options Dialog, Bind Utility, and Linker Config (Link Profile) UIs have been removed with the exception
of error messages in the SQLWizard, Migrate, and Declaration Generator.

Significant Changes in Behavior or Usage
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:
•
•
•

Enterprise Server
Resource Adapters
REST/JSON IMTK implementation and the same-origin policy (SOP)

Enterprise Server
•

On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Resource Adapters
•

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)
•
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HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.

Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Adis
Character Animator
COBOL to XML Schema generation
Codeset Support
Common Communications Interface
Data Tools
Documentation
Embedded HTML Pre-Processor
Enterprise Server
File Handling
Micro Focus Directory Server
Monitoring and Management
OLE Class Library
OpenSSL
REX Support
RM/COBOL
Run-Time System
SQL: COBSQL
SQL: OpenESQL
SQL Option for DB2
XML Support

Adis
Back to the list
•

PIC N items are now filled with double-byte space when required by ADISCTRL options 15 and 16.
2913183 (1108448)

Character Animator
Back to the list
•

The Break>Cancel-All option no longer occasionally freezes the Animator.
2879817 (1107460)

COBOL to XML Schema generation
Back to the list
•

CBL2XML now handles namespace correctly.

•

2861655 (1104748)
CBL2XML now correctly handles non-default type within <restriction>.
2826345 (1100279)

Resolved Issues
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Codeset Support
Back to the list
•

The Codeset DBCS tables MFTR0886.A2E MFTR0886.E2A have been updated to match the latest IBM
Traditional Chinese conversion tables below: Description of 9027: T-Ch Host Double-Byte including
6204 UDC including euro. Description of 21427: T-Ch DBCS-PC (IBM BIG-5) including 13493 CNS, 566
IBM selected, 6204 UDC & euro.
3104948 (1109314)

Common Communications Interface
Back to the list
•

•

Using CCI shared memory and receiving data with a max receive length less than the total amount of
data received resulted in the data being received incorrectly on the final receive. This has now been
fixed.
After a communications failure, Enterprise Server shared-memory listeners would sometimes stop
accepting new connections. This has now been fixed.

Data Tools
Back to the list
•

Vision and RM files that contain a null (0x00) byte in the key now function correctly in the Data File
Editor.
2882159 (1107598)

•

The following minor enhancements have been made to the Data File Editor: - Previous filter conditions
are now remembered for each file when the dialog is loaded. - The default filter operator now defaults to
'Contains'. - Field attributes for reference conditions now default to 1:max-rec- length, instead of 1:1.
2878521 (1107104)

Documentation
Back to the list
•

•
•

The product documentation has been updated to include information and syntax for secure access to
MFDS (mfds /b).
2854625 (1103606)
Documentation for environment variables has been improved.
The casstart /w parameter prevents the casstart process from exiting until the region has either started
or failed to start correctly.
2868898 (1105712)

•
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A "redundant" or "high-availability" mode is now available in the Enterprise Server External Security
Facility. It enables you to configure multiple equivalent Security Managers and let processing continue
as long as at least one Security Manager is available. To enable this feature, add the following to the
configuration text area for the security configuration (either in the default Enterprise Server Security, the
MFDS Security, or on the Security tab for a specific enterprise server): [Operation] redundant=yes

•

2989911 (1108665)
Additional information on the Web Services and J2EE conversation type has been added to the
"Configuring Listener Conversation Types" chapter in the product documentation.

•

2877270 (1106896)
The product documentation has been updated to include information on converting the input file used by
casrdtup from EBCIDIC to ASCI.

| Resolved Issues

•
•
•

2863611 (1104940)
The documentation for bit zero of the 'thread-state' parameter of CBL_THREAD_LIST_START and
CBL_THREAD_LIST_NEXT has been corrected.
Documentation of CBL_LOCATE_FILE parameter corrected.
The installation instructions included incorrect information about users having to stop and uninstall an
existing Micro Focus Directory Server (MFDS) or CCITCP2 Windows service (on Windows) or a
process (on UNIX) from an existing product. This has been removed from the product help.
2877431 (1106934)

Enterprise Server
Back to the list
•

An issue where SOAP elements were not mapped to COBOL code has been resolved.

•

3106199 (1109416)
When SOAP headers were part of the SOAP request, you no longer receive a "SOAP header
malformed" response.

•

3105803 (1109367)
An issue where a handler program in the pipeline caused issues with JSON GET/DELETE/HEAD
requests has been fixed.

•

•

•

3104977 (1109274)
An UNDEFINED_ELEMENT error message occurred when a JSON message (under CICS WEB
SERVICES) did not include an object that was present as a "record 1" item in the wsbind or the jsbind
files.
3102943 (1109085)
When a CICS Web Service was invoked with no port in the URI, the default port for the scheme was not
set up.
3100280 (1108870)
EXEC CICS SEND and CONVERSE commands now send all user-written headers (EXEC CICS
WRITE HTTPHEADER) even if the user provided values that contain null bytes. When browsing
headers with EXEC CICS WEB READNEXT HTTPHEADER, CICS will now initialize the buffers that
were supplied for the header name and value.

•

2990561 (1108733)
A problem where a system process (CASTRC) was unable to allocate any local storage and, as a
result, became unresponsive, has been resolved.

•

2886741 (1108236)
Casout commands running in a loop from the same process used to exhausting resources. This was
caused by an invalid path concatenation.

•
•

2886407 (1108426)
An issue resulting in a Run-Time System error 205 "Invalid mainframe pointer" has been fixed.
2885280 (1108041)
TRANSFORM was failing in situations where an XMLTODATA TRANSFORM contained an XML
declaration with EBCDIC encoding.

•

2885262 (1108040)
The EZASOKET traces are now controlled by a COMMS trace flag.

•

2884491 (1108174)
Caching has been added for TS queues security checks.
2884070 (1108789)

Resolved Issues
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•

Commarea overrides are now honored for non-facility transactions.

•

2884049 (1107879)
Usernamelen and passwordlen options are not mandatory on exec cics web converse and web send
(client).

•

2880669 (1107365)
Previously, using multiple CICS LINK statements (linking A to B to C and so on) could result in an RTS
error 114 in the CAS system modules.

•

2880542 (1107372)
The spool active job queue will now display any jobs that were started prior to resetting the time for DST
but that have not completed yet.

•

2879116 (1107204)
The debug file name generated when using CICS Web Services now includes the process ID and the
task number. For example - inquireCatalogClient-19556(00028)-CWS-REQUESTER.TXT.

•

•

2878485 (1107077)
The SOAP to COBOL mapping under CICS Web services was incorrect when an optional element had
no child elements (where the schema defined a minimum of one such child element and these child
elements have been mapped to a container). In such cases, the number of instances of the child
element would have an incorrect value of 1 where it should be 0.
2877043 (1106879)
If you used XA with more than 7281 transactions or had a number of JCL jobs that used XA, a record
could be split across multiple blocks. After restarting the enterprise server, a large number of
CASXO0029I errors were reported in the console log file. A block that can hold up to 7282 records is
now used.

•

2874024 (1106469)
When casout is used to release a job, casmgr now attempts to dispatch the job immediately rather than
waiting for its next dispatch cycle which previously could take 20 seconds.

•

2873224 (1106621)
If there were more than 20 TRANCLASS instances specified in the startup list, this could cause
memory corruption.

•

2868129 (1105682)
The ESFCA0401I Cache Termination message is now available for JES, IMS DB, IMS TM, MQ, and
iFileshare processes.

•

2866750 (1105376)
A duplicate security check about whether the user has enough permissions to run a JCL job has been
removed.

•

•

•
•

2866526 (1105336)
When eci-tpn is used on a call to ECI for CTG or the Micro Focus implementation of ECI, Enterprise
Server now verifies the transaction exist and is enabled. If the transaction is disabled, an abend AZI6 is
returned. This is mainframe-compatible behavior.
2863500 (1105165)
An EXEC CICS LINK to a non-CICS module now handles the data context correctly and you no longer
receive CDCD abends on any further LINKs.
2858747 (1104275)
CASxx5006I messages now display a return code.
2853609 (1103516)
All ESMAC pages are now secured. Users who are not authorized now receive an error message when
trying to access any of these pages in their browser.
2843901 (1102247)
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•

The CICS WEB services now support SOAP 1.2.

•

2822822 (1099723)
An issue that could cause an RTS error 119 on a casout command when starting a batch initiator has
been fixed.

•

An issue with certain length DNs that could cause DNs to become truncated has now been fixed.

•

•

•

•

•

3103303 (1109366)
If nested groups (user groups containing other groups) were used with LDAP-based security for
Enterprise Server, it could result in Enterprise Server hanging at region startup, or users might not be
assigned all of their groups. This has now been fixed.
2988205 (1108935)
The "check TLQ first" option has been added to the MLDAP ESM. The option can change the Rule
processing algorithm. This option might improve performance when there are large numbers of
resources in a class.
2875051 (1106874)
Enterprise Server no longer crashes on startup if LDAP-based external security with the "all-groups"
and "redundant" options are both specified, but the "federated groups" option is not.
2874010 (1106529)
If the esfupdate utility is used to request an update of security information for a user, and that user was
originally signed onto the system using a lowercase representation of their user ID, the update now
correctly identifies and updates the user.
2871297 (1106164)
If the MFDS Security Configuration specifies that verify requests should be cached and the cache TTL
and limit values are non-zero, for example, the MF Directory Server Security configuration page
Security Facility configuration text contains: [Cache] requests=verify If a new password was specified in
a Web interface logon request, then previously it was being ignored. Previously, if the user was logging
on with an expired password and attempting to change the password the request would also be ignored
and an expired password error would be returned.
2868342 (1105626)

•

An RTS 205 error during the execution of an AMODE application could occur when Assembler address
0 was erroneously de-registered. This is now fixed.
3104561 (1109229)

•

Under heavy loads, the ESFCA0401I log messages were not appearing at the correct intervals.
2863222 (1104948)

•

•

Enterprise Server listeners that are configured for TLS (also known as SSL) no longer hang if a client
connects to them without sending any data.
2873177 (1106408)
In some HotFix releases of earlier versions of Enterprise Developer and Enterprise Server, SSL or TLS
connections to an Enterprise Server could hang if client certificates were used and there was a delay of
at least several seconds before the certificate was sent.

Embedded HTML Pre-Processor
Back to the list
•

The XML run-time system did not handle data items with the OCCURS clause correctly.
3107418 (1109566)

Resolved Issues
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File Handling
Back to the list
•
•

•

•

The ESF LDAP Security Administration Web Interface now has a logoff button.
2871551 (1106117)
If data compression is specified when trying to open a fixed block file, when running under a mainframe
dialect, the File Handler now checks to see if it is trying to open a VB file. If it isn't, compression will be
turned off and the file will be opened as normal.
2870022 (1105956)
An internal field used to store the current file status was being overwritten by the allocation of a buffer.
Now we store it off beforehand so its value can be restored, and an accurate file status returned.
2868664 (1105707)
When certain in-flight rewritten records were rolled back at the end of a transaction, the File Handler
was setting incorrect values for the length field in some records and various warning messages were
displayed during index file validation.
2864802 (1106106)

•

•

A CBL_FREE_MEM statement in Fileshare was missing a 'by value' clause, which was causing a runtime error. This is now fixed.
2883421 (1107767)
When running under Fileshare, a delete on a locked record no longer results in a record locked status if
the same user had previously obtained a read lock on the file.
2832909 (1108287)

•

When REBUILDing from SEQ into IND with duplicate key, you will no longer get a corrupted file if you
do not specify the target flag /t.
2880311 (1107302)

•

CSF to ZD negative sign conversion is now handled correctly during a sort operation.

•

3103118 (1109125)
JCL SORT no longer abends if no record is rewritten to a DUMMY data set.

•

3102468 (1109052)
Sorting ESDS files to RRDS files no longer truncates the first 4 bytes of each record.

•

•
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3101385 (1109112)
Variable length SORT OUTFIL files are now created correctly when more than one data set is specified
in the targeted OUTFIL.
2881629 (1107551)
MFSORT INCLUDE will no longer include the first record in the concatenated file if, according to the
parameters, that record should be excluded; previously, the first record was included regardless of the
parameters.

•

2876259 (1106785)
For an MFJSORT, a combination of numeric tests and logical comparisons now returns the correct
records.

•

2870986 (1106216)
When copying concatenated files in MFJSORT, for sequential fixed block, the correct number of record
is now used.

•

2870506 (1106057)
MFJSort now produces the correct number of records regardless of the value of the SORTSPACE
setting.

| Resolved Issues

•

2867668 (1105534)
An error when writing the ICETOOL listing from an empty input file has been corrected.
2866176 (1106459)

Micro Focus Directory Server
Back to the list
•

Fixed a memory leak in the MFDS process.

•

2876419 (1106799)
A memory leak in the MFDS process occurred if non-SSL-enabled connection attempts were made
against an SSL-enabled MFDS. This has now been fixed.

•

2869493 (1106567)
The MFDS -g command-line option now correctly handles the import of multiple region definitions from
a single XML file.

•
•

2840162 (1101798)
An issue that could potentially cause heap corruption in MFDS if the configuration data for an individual
object was greater than 1K has been fixed.
The "Renew" option available in the Enterprise Server Administration Web interface now works if SSL is
enabled.

Monitoring and Management
Back to the list
•

•

Spurious STEP BYPASSED events for dummy steps were being passed to the user exit and the HSF
exit.
2873504 (1106446)
An issue where duplicate HSF records could be created has been fixed.
2856941 (1103977)

OLE Class Library
Back to the list
•

A problem with accelerator keys being handled by an ActiveX control has been fixed.
2990224 (1108719)

OpenSSL
Back to the list
•

The version of OpenSSL included in this product has been updated to version 1.0.2j.

REX Support
Back to the list
•

•

When running a REXX EXEC under Enterprise Server or Enterprise Server for .NET, an "Invalid
Expression" error occurred for an assignment statement where the expression being assigned to the
variable had been omitted. An empty string is now assigned to the variable if the expression is omitted.
2880655 (1107390)
A REXX exec could fail with a S0C4 abend or an RTS 114 error if it was greater than 4096 bytes in
length and specified either as in-stream data or catalogued as an RECFM=F or RECFM=V dataset.
2878613 (1107100)

Resolved Issues
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RM/COBOL
Back to the list
•

When FILETYPE(21) was specified for a LINE SEQUENTIAL print file, you could receive a Run-Time
System error "13". Writing to a printer from a Visual COBOL program through the RM File Manager
(filetype 21) now works correctly.
2874987 (1106616)

Run-Time System
Back to the list
•

•

3104586 (1109231)
A error when using very long command lines with Profiler (or cobprof on UNIX) has been fixed.

•

2884968 (625185)
You can now double-click (to run) managed executables that use the ACUFH file handler; previously,
they may have failed with a COBRT198 error.

•

2880827 (1107388)
When debugging a native Object COBOL application, the debugger no longer fails with an intermittent
COBRT114 run-time error when getting the type and value of an object's handle.

•

•

•
•

•
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Adis SCREEN SECTION ACCEPT statements for PIC N DISPLAY-1 items now correctly accept DBCS
characters with a lead byte of x"87".

2875531 (1106808)
A multi-threaded application that makes use of the COBOL syntax for handling mutexes, monitors,
events and semaphores, or the corresponding CBL_ APIs, no longer fails intermittently with various runtime errors due to memory corruption.
2860205 (1104446)
Animating a core file that has been moved to a different directory, for a core file produced by an
application compiled to executable, no longer fails with a "Program is not animatable" error. Previously, it
would on certain platforms.
2856631 (1103933)
Detaching from animation that was started using the debug_on_error tunable could cause animation to
re-start again for the initial error - this has now been resolved.
In managed COBOL, a CANCEL data-name statement no longer fails or crashes if the contained
program name is not space-terminated.
2887392 (1108320)
Using user-defined class conditions in managed code no longer gives incorrect results.

•

2887005 (1108290)
When executing a SQLCLR stored procedure for a second time, programs not found during the first
execution might not be found dynamically.

•

2879012 (1107201)
The backtab key now works correctly when performing ADIS screen i/o operations in managed code
applications.

•

2877480 (1106928)
Using the CBL_FILENAME_CONVERT library routine resulted in receiving an exception in managed
COBOL if bit 3 was set for the function parameter and CTF tracing was then enabled.

•

2876179 (1106763)
An environment variable with a value containing a leading space is no longer treated as having been
deleted.

| Resolved Issues

•

2872919 (1106405)
A CANCEL of a dataname containing low values no longer causes a Run-Time System error in
managed COBOL code.
2872140 (1106247)

•

A 12-byte (32-bit) memory leak has been prevented when calling native COBOL code from JVM
COBOL when using the 'C' call-convention, or the RuntimeSystem.cobcall/cobrcall library APIs, with a
parameter type that is a JVM array.

SQL: COBSQL
Back to the list
•

A problem that caused the COBSQL preprocessor to incorrectly parse comments beyond column 72
has been fixed.

•

3101746 (1108980)
A problem with COBSQL producing a duplicated cursor data item when KEEPCOMP was used has
been fixed.

•

2874051 (1106531)
A problem that caused the COBSQL preprocessor to incorrectly process source lines with characters in
column 73 and beyond has been fixed.
2869958 (1109899)

SQL: OpenESQL
Back to the list
•

•

The OpenESQL preprocessor incorrectly expanded a group host variable used in a CURSOR SELECT
statement, resulting in a run-time error. The preprocessor has been modified to generate a COBES0130
error message in this case.
3104602 (1109289)
A problem the prevented OpenEQL applications calling SQL Server stored procedures with no
parameters when using the legacy 'SQL Server' ODBC driver has been fixed. Important: We strongly
discourage use of the legacy 'SQL Server' ODBC driver. Instead, we recommend that for best
performance and functionality, use the ODBC driver that corresponds to the version of SQL Server used
by the application.

•

3100550 (1109071)
A problem with HCOSS code generation that occurred when duplicating input host variable references
(for example when substr() is used with 2 rather than 3 parameters) has been fixed.

•

3100098 (1108819)
A problem with the OpenESQL native routine that provides DSNTIAR emulation sometimes caused an
RTS114 error. This has been fixed.

•

•

•

2989595 (1108699)
A new OpenESQL directive, GEN-SQLCA, has been added to generate the SQLCA copybook in a
program when it has not been explicitly included. This directive provides additional support when
migrating applications compiled with STDSQL(YES) on the mainframe.
2887858 (1108368)
A problem with the MSSQL XA switch module sometimes causing a CICS transaction to abort if it
ended without closing all FORWARD and READ ONLY cursors has been fixed.
2887074 (1108340)
An inconsistency in reporting data truncation warnings when using PostgreSQL has been fixed.
2886648 (1108201)

Resolved Issues
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•

•

2884651 (1107997)
A problem when using OpenESQL for JDBC with the "Use Dynamic Calls" project option has been
fixed.

•

2883500 (1107955)
A problem with SQL(AUTOFETCH) that affected SQL Server FORWARD READ ONLY WITH HOLD
cursors performance has been fixed.

•

2880840 (1107580)
The ADO.NET Run-Time System for OpenESQL now returns the correct value in SQLERRD(3) after a
cursor fetch when other statements are executed between any fetches on the cursor.

•

2880814 (1107386)
OpenESQL now allows FREE to be used as an SQL identifier. It is server dependent if this is supported
at compile time when using SQL(CHECK) and at run time.

•

2880673 (1107368)
A new OpenESQL directive, CLOSE_ON_COMMIT, has been added to provide greater control over
cursor behavior on COMMIT for cursors that are not explicitly declared using WITH HOLD.

•

2879558 (1107305)
A problem with HCOSS handling of nested table references in DB2 statements has been fixed and error
messages when using SQL(STRICTPARSE) have been improved.

•

•
•

2879503 (1107286)
The SQLBGP COBSQL compiler directive option has been added to ensure successful background
parsing of EXEC SQL statements when the Pro*COBOL installation resides on a remote machine and
not on the local machine.
2877618 (1107292)
A problem that prevented SQL(CHECK) from working correctly on some databases has been fixed.
2877284 (1107021)
When used with the SQL(USER-SQLDA=MAINFRAME) directive, the OpenESQL preprocessor could
incorrectly generate ES0100 errors if a group variable was used in an EXEC SQL FETCH statement.
This has been fixed.

•

2876420 (1106803)
The OpenESQL preprocessor sometimes failed to return comp data items correctly if compiled with
SQL(DIALECT=MAINFRAME). This has been fixed.

•

2874931 (1106606)
The OpenESQL preprocessor has been updated to generate a more meaningful message,
COBES0129, when it encounters an undefined host variable.

•
•
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OpenESQL and OCI have been updated to to prevent RTS198 errors when using DSNTIAR with
ODBC. To take advantage of this new functionality, specify the cob -d command flag to resolve
DSNTIAR with the correct callable shared object. For example, to compile a COBOL program into an
executable on a 64-bit platform with OESQL DSNTIAR: cob -x program.cbl -d
DSNTIAR@cobmfdsntiar64.so -L$COBDIR/lib -lmfpliz -lplidump -llmgr -lm Or, to compile a PL/I
program into an executable on a 32-bit platform with OESQL DSNTIAR, execute the following two
commands: mfplx -c PROGRAM.pli -sql odbc -optsql "behavior=mainframe nosmftrace" cob -x
PROGRAM.o -d DSNTIAR@cobmfdsntiar.so -L$COBDIR/lib -lmfpliz -lplidump -llmgr -lm

| Resolved Issues

2874408 (1106624)
A problem with SQL(NORSLOCATORS) leaking SQL Server server cursors has been fixed.
2872613 (1106294)
HCOSS handling of the DB2 CHAR() function did not always properly apply the compile-time settings of
DATE and TIME as the default formats when CHAR was called with a date or time value but no date or
time format parameter was supplied. This has been fixed.

•

•

•

•
•

•
•

•

2872518 (1106404)
A new SQL compiler directive option, OPTIMIZECURSORS, has been added to optimize memory
consumption when using OpenESQL for ADO.NET with Oracle, DB2, or PostgreSQL. The default
setting is SQL(OPTIMIZECURSORS=YES). See the OPTIMIZECURSORS reference topic in the
documentation for complete information.
2871132 (1106056)
Decimal and host variables with the same length are now converted to EBCDIC correctly when
CHARSET(EBCDIC) is enabled; however, if you link native COBOL applications that use display
numeric variables in SQL statements using CHARSET(EBCDIC), you might get a link error. To resolve
this issue, see the OpenESQL topic under Known Issues and Restrictions.
2857755 (1104091)
A problem with the ODBC switch module not reporting broken connections to Enterprise Server when
xa_start() is called has been fixed.
2843672 (1108847)
A problem that caused the OpenESQL preprocessor to incorrectly interpret UNICODE(PORTABLE) has
been fixed.
The SQL xa_open string has been updated to include the PACKAGEPATH option, which enables the
use of substitution markers to customize the package path based on the current JCL or CICS user
name, XA resource name, enterprise server region name, or a combination. In addition, when used with
the UserP option, the PACKAGEPATH option value changes when the user for the connection changes.
A problem using SQL(DATEDELIM) with SQL(DATE=JIS) has been fixed.
OpenESQL has been updated to enable execution of selected SQL statements at compile time. You can
use this functionality to create temporary tables during compilation and to enable the use of
SQL(CHECK) with temporary as well as permanent tables.
The encoding of the sqltype fields in SQLDA has changed and any applications that use dynamic SQL
with SQLDAs might require application code change. The new sqltype encoding scheme adds 0x2000
to sqltype when an integer, a small integer or a big integer host variable is COMP and 0x1000 and when
any indicator host variable is COMP. Otherwise, COMP-5 is assumed for indicators and for integer,
small integer and big integer host variables.

SQL Option for DB2
Back to the list
•

A problem with the Declaration Generator that prevented COBOL copybooks from being generated
correctly for tables with timestamps and XML columns has been fixed.
2875742 (1106868)

•

•

The XDB preprocessor has been updated to support source connect files that previously generated a
"File not found" error for EXEC SQL INCLUDE statements located on the source connect drive.
2912819 (1108471)
The XDB ECM has been enhanced to handle temporal table query syntax.
2876438 (1106807)

•

Implemented the JDBC ResultSet Interface getBigDecimal methods that do not require a scale
argument: getBigDecimal(int columnIndex) and getBigDecimal(String columnLabel).
2877817 (1106963)

•
•

A problem that caused an X020 syntax error on SELECT DISTINCT (TRIM)has been fixed.
3105393 (1109324)
A problem that prevented the XDB engines to successfully process a COUNT(DISTINCT expression)
scalar function when the expression was a concatenated expression enclosed in parentheses has been
fixed.

Resolved Issues

| 21

•

2884227 (1107903)
A problem that caused a thread stack overflow on scalar function recursions that use CONCAT has
been fixed.

•

2884046 (1107882)
A problem with the XUTLB LOAD grammar prevented the reserved word DATE from being used as a
table name. This has been fixed.

•

2882727 (1107652)
An problem when correlating a subquery produced a PDMP242 error. This has been resolved.

•

2880672 (1107367)
A problem that caused a FETCH FIRST clause in a scalar subquery to be ignored has been fixed.

•

2880671 (1107366)
A problem using the reserved word DOCUMENT as an identifier in the first argument of a scalar
function has been fixed.

•

2874154 (1106483)
CAST AS TIMESTAMP using the special character 'T' as the date/time delimiter was not allowed. This
is now allowed.

•

2874153 (1106484)
An issue with the ordering of a result set caused the incorrect row to be returned on a FETCH FIRST
ONLY clause. This has been fixed.

•
•

2873389 (1106391)
A problem that sometimes caused the XDB Server to shut down before completing location checkpoint
operations by maintenance threads has been resolved.

•

2847090 (1102750)
An problem with LIKE predicate index query optimization that caused missing result set rows has been
fixed.

•
•

2841168 (1101910)
A problem that prevented the restoration of LOB data from a record with an LOB column after deleting
the record and then rolling back from a Save Point has been fixed.
XDBMONN has been updated to issue the correct error message when it is started, but the server is
not running.

•

The server Name be displayed in the status bar of the XDB SQL Wizard.

•

2865763 (1105197)
Using ALLOW EDITING on an SQLWizard result set could result in the query being corrupted. This has
now been fixed.

•
•
•

•
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2873390 (1106435)
An issue with index optimization of LIKE predicate processing has been resolved.

| Resolved Issues

2865336 (1105171)
The restriction that prevented the editing of result sets generated from alias tables has been removed.
2857585 (1104067)
When the SQLWizard is invoked by MFA Drag & Drop to import unload data to a table it no longer
returns an X352/X95 error.
A problem that sometimes occurred when using the DB2(NOHCO) compiler directive option caused the
return of incorrect codes at completion of program execution. This has been fixed.
3100172 (1108872)
The DB2 preprocessor has been updated with a new DB2 compiler directive option, QUALIFY-CALL,
that works with the QUALIFIER compiler directive option to qualify DB2 EXEC SQL CALL statements
with the schema name specified by the DB2 QUALIFIER directive.

•

2884948 (1108032)
The DB2 ECM has been updated to prevent an undefined ECM error when indicator variable arrays are
used in SELECT SQL statements.

•

2884605 (1107947)
The DB2 ECM preprocessor has been updated to support host variables defined as SQL TYPE IS XML
AS BLOB-FILE/CLOB-FILE/DBCLOB-FILE.
2839654 (1101707)

XML Support
Back to the list
•

XMLPARSE no longer returns -19 in XMLSS mode.

•

2913116 (1108661)
Opened XML files are now closed when the COBOL program called by JCL is terminated.

•

•

2885450 (1108132)
A new directive "OUTENC(INPUT)" is created to ensure encoding of the output text will be the same as
the input encoding specified in the XML declaration.
2870879 (1106332)
XMLIO now handles REDEFINE data items correctly.
2795744 (1096302)

Resolved Issues
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
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2884374 (1107928)
2875256 (1106645)
2871954 (1106649)
3103304 (1109198)
2857117 (1106716)
3106240 (1109462)
2989573 (1108689)
2874306 (1106666)
2848671 (1102872)
2878662 (1107084)
2864100 (1104959)
3101450 (1108990)
2884755 (1107973)
2884754 (1108098)
2883962 (1108118)
2883962 (1108119)
2878826 (1107101)
2878227 (1107012)
2877589 (1106938)
2875248 (1106679)
2874812 (1106627)
2874077 (1106516)
2872027 (1106210)
2869739 (1105894)
2868086 (1105954)
2864170 (1105040)
2864164 (1105035)
2990780 (1108760)
2884757 (1108096)
2883769 (1107830)
2851153 (1103313)
3101883 (1108971)
3101148 (1108902)
2885725 (1108103)
2884537 (1107964)
2878485 (1107076)
2876638 (1107036)
2872931 (1106328)
2872035 (1106199)
2867270 (1106437)
2837526 (1104757)
3101467 (1109005)
2879947 (1107389)
2879908 (1107247)
2878412 (1107371)
2852872 (1107046)

| Other Issues Resolved in This Release

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2989831 (1108862)
2875722 (1106767)
2875245 (1106642)
2858289 (1104218)
2839585 (1102006)
2869862 (1105851)
2857086 (1104025)
2831639 (1100766)
3102063 (1108996)
3101684 (1108956)
2884727 (1108008)
2881493 (1107488)
2860914 (1104582)
3105709 (1109380)
3105708 (1109382)
3105707 (1109383)
3105704 (1109377)
3105703 (1109374)
3105221 (1109372)
3105219 (1109379)
3105218 (1109371)
3105217 (1109375)
3105217 (1109376)
3105216 (1109370)
3105215 (1109368)
3105214 (1109369)
3104634 (1109245)
3103928 (1109267)
3103824 (1109284)
3102104 (1109041)
3101976 (1109010)
3101690 (1109039)
3101030 (1108911)
3101028 (1108930)
3101027 (1108932)
3100325 (1108856)
2988233 (1108531)
2912393 (1108452)
2912391 (1108451)
2912389 (1108442)
2912387 (1108439)
2912355 (1108501)
2912354 (1108450)
2887976 (1108736)
2887970 (1108418)
2887419 (1108331)
2886979 (1108286)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2879488 (1107196)
2877587 (1106984)
2877474 (1106937)
2877189 (1106921)
2874594 (1106590)
2874591 (1106575)
2874313 (1106592)
2873877 (1106610)
2872737 (1106316)
2872474 (1106964)
2871631 (1106297)
2869907 (1106670)
2869898 (1106147)
2869892 (1105900)
2869763 (1105896)
2864092 (1106070)
2852872 (1103790)
2852872 (1106311)
2852872 (1107278)
2799183 (1096680)
2991138 (1109121)
2875556 (1106727)
2873522 (1106485)
3101858 (1109029)
2883840 (1107954)
2882062 (1107704)
2871525 (1106466)
3106697 (1109529)
3109683 (1109781)
2871797 (1106201)
2816310 (1104173)
3100167 (1108936)
2989831 (1108879)
2796532 (1096369)
3105586 (1109338)
3105375 (1109313)
3102818 (1109347)
2875983 (1106861)
2875103 (1106822)
2988894 (1108994)
2870824 (1106018)
2875885 (1106721)
2886300 (1108160)
2883994 (1108116)
2876768 (1106926)
2875396 (1106686)
2887853 (1108380)

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

2881573 (1107673)
2878429 (1107279)
2876370 (1107219)
2871569 (1106143)
2867842 (1105600)
2867117 (1105493)
2853200 (1103409)
2885043 (1108044)
2876773 (1106847)
2869095 (1105803)
2865595 (1105786)
2860304 (1104472)
2883686 (1107844)
2865350 (1105129)
2864599 (1105025)
2873863 (1106487)
2870740 (1106000)
2866084 (1105259)
2864758 (1105772)
2989939 (1108666)
2878067 (1106990)
2877643 (1107028)
2873883 (1106635)
2819070 (1099603)
2657473 (1090356)
2869213 (1105788)
3103252 (1109178)
3103241 (1109176)
2991312 (1108795)
2887454 (1108358)
2882453 (1107614)
3100079 (1108823)
2887733 (1108399)
2880976 (1107464)
2877232 (1106950)
3102272 (1109059)
3101639 (1109086)
2886684 (1108370)
2884612 (1108024)
2879358 (1107190)
2878631 (1107110)
2877721 (1106966)
2876808 (1106856)
2876719 (1106845)
2875613 (1106730)
2873607 (1106420)
2873447 (1106429)

•
•
•
•
•
•
•
•
•
•
•
•
•

2851640 (1103228)
2603382 (1087028)
2871769 (1106474)
2876285 (1106842)
3107224 (1109628)
2880556 (1107803)
2879876 (1107263)
2880593 (1107378)
3105620 (1109342)
2991280 (1108799)
2882386 (1107606)
2881902 (1107890)
2879176 (1107150)

•
•
•
•
•
•
•
•
•
•
•
•

2885859 (1108130)
2885529 (1108083)
2884236 (1108000)
2883551 (1107800)
2881659 (1107500)
2881243 (1107455)
2881040 (1107414)
2881038 (1107416)
2881037 (1107419)
2881036 (1107423)
2880647 (1107399)
2879819 (1107333)

•
•
•
•
•
•
•
•
•
•
•
•

2883907 (1107872)
2874406 (1106565)
2873249 (1106552)
2871661 (1106145)
2863482 (1104862)
2848848 (1102895)
2866216 (1105926)
2883667 (1107815)
2880475 (1107343)
2871842 (1106178)
3102432 (1109463)
2887808 (1108624)

•
•
•
•
•
•
•
•
•

2873158 (1106378)
2873035 (1106735)
2871178 (1106125)
2870557 (1106194)
2865051 (1105317)
2859144 (1104286)
2146936 (1059549)
2876653 (1106832)
2865001 (1105155)

Other Issues Resolved in This Release
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Unsupported Functionality
The following features or functionality are no longer supported:
•
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The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.

| Unsupported Functionality

Installation
Before Installing
Downloading the Product
1. Use the download links in your Electronic Product Delivery email.
For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows
System Requirements
Hardware Requirements
The disk space requirements are approximately:
COBOL Server
800MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.
Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Software Requirements
Note:
•
•

The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.
This product includes OpenSSL version 1.0.2j.

Before installing this product, you must have the following software installed on your computer:
•

The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:
•

Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.
To download the Microsoft .NET Framework 2 click here.
Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.

Installation
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Note:

•

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
• .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.
• .NET Framework 4.6.2 is provided with Windows 10 and Windows Server 2016.
Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

•

A Web browser is required for Enterprise Server Administration in COBOL Server.

•

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).
To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems, apart from
Windows Server 2003. Also, active content must be allowed and not blocked. To enable both these in
Internet Explorer:

•

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click
Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active
content to run in files on My Computer is checked.
Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable
the Search facility to work.
Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file.
Click here to see this information on the Micro Focus Infocenter.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:
•
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You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

•

Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:
1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:
net stop mf_ccitcp2
Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.
For MFDS, from a command line prompt enter: mfds -u
For CCITCP2: ccitcp2 -u
To run an earlier version of MFDS as a service after you have installed a later version:
1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:
a. Open a COBOL Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2
Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.
MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.
It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Product Co-Existence
Note: The following applies to Windows only.
•

Visual COBOL and COBOL Server cannot coexist on the same machine.

On UNIX
System Requirements
Hardware Requirements
The disk space requirements are approximately:
Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

license server

the installation

running
the product

POWER
running AIX

Micro Focus

368 MB

1.47 GB

736 MB

35 MB

HP IA

Micro Focus

710 MB

2.84 GB

1.42 GB

66 MB
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Platform

Installer type

Setup

Disk space

Disk space

Sentinel RMS

file size

required for

required for

license server

the installation

running
the product

System Z
Micro Focus
running Red Hat
Linux

295 MB

1.18 GB

590 MB

34 MB

x86-64 running
Red Hat Linux

Micro Focus

313 MB

1.25 GB

626 MB

44 MB

ppc64le running Micro Focus
Red Hat Linux

201 MB

804 MB

402 MB

1 MB

SPARC running
Solaris

Micro Focus

356 MB

1.42 GB

712 MB

38 MB

x86-64 running
Solaris

Micro Focus

330 MB

1.32 GB

660 MB

30 MB

System Z
running SUSE
SLES

Micro Focus

184 MB

736 MB

368 MB

1 MB

x86-64 running
SUSE SLES

Micro Focus

318 MB

1.27 GB

636 MB

44 MB

ppc64le running Micro Focus
SUSE SLES

184 MB

736 MB

368 MB

1 MB

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.
Software Requirements
Note: This product includes OpenSSL version 1.0.2j.
Before installing this product, you must have the following software installed on your computer:
•

•

The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax -version at the command line.
Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.
If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.
Library
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32-bit
Library
Name

64-bit
Library
Name

Platform
s390

SUSE 11

SUSE 12

Red Hat 6.x

Red Hat 7

glibc

glibc-*.i686 glibc*.x86_64

glibc*.s390

X

X

libgcc

libgcc*.i686

libgcc*.s390

X

X

libgcc*.x86_64

Library

libstdc++

32-bit
Library
Name
libstdc++*.i686

64-bit
Library
Name
libstdc++*.x86_64

Platform
s390

SUSE 11

SUSE 12

libstdc++*.s390

Red Hat 6.x

Red Hat 7

X

X

Visit the Red Hat Web site for more information.
•

Oracle's Java Platform (64-bit) version 1.8.92 or above is required. Java 7 and 8 (32 or 64-bit versions)
are supported for executing JVM COBOL code and for native COBOL and Java interoperability. You can
download Oracle's Java EE from Oracle's Web site and install it anywhere on your machine.
Note:
•
•

On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.
On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

Before you start the installation, you need to set the environment as follows:
•
•

•

You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:
set classpath=jdk-install-directory\lib\tools.jar
JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.
Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.
If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.
You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file.
Click here to see this information on the Micro Focus Infocenter.
Browser
Back to Top
Browser versions which can be used for embedded browser support (such as SWT) and their
corresponding Eclipse versions are listed here.
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Note: Eclipse 4.5 and newer support Mozilla 1.4 GTK2 - 1.7.x GTK2, XULRunner 1.8.x - 1.9.x, 3.6.x,
10.x, 24.x and 31.x (but not 2.x nor other unlisted versions), WebKitGTK+ 1.2.x and newer (Eclipse
4.5 support for XULRunner 31.x is not available on Linux due to Bug 467646.). For Eclipse 4.6 you
must install a 64-bit browser version.

UNIX and Linux Installer Issues
Installing while using AFS/Kerberos authentication
If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Visual COBOL components of the product can use. This user ID must
be set up prior to running the installer. When running the installer you need to specify EDadminID=[User ID] on the command line so it is used by the installer.
License Server
You need to configure the computer hostname to ensure the license server will start properly.
To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.
The following is an example of how to specify these entries correctly in the /etc/hosts file:
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.
For considerations when installing this product as an upgrade, for additional installation options or nondefault installations, see Advanced Installation Tasks in your product Help.

Installing on Windows
Note: If there is an earlier version of COBOL Server installed on your machine, check Installing as an
Upgrade first.
These are the steps to install this product:
1. Run the cs_30.exe file and follow the wizard instructions to install the prerequisite software and the
product.
The setup file will also install any missing prerequisite software as listed in Software Requirements.
Note:
•
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If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove

•
•
•

Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.
Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.
We recommend that you install any updates for the .NET Framework that are available at the
Microsoft Download site.
If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with COBOL Server but you can install it if you wish.

Installing on UNIX
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.
These are the steps to install this product using the Micro Focus installer:
1. Give execute permissions to the setup file:
chmod +x setup_cobol_server_3.0_platform
2. Run the installer with superuser permissions:
./setup_cobol_server_3.0_platform
If you don't run this as superuser, you are prompted to enter the superuser password during the install.
If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.
The COBOL run-time is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).
SafeNet Sentinel considerations
•

•

The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:
./setup_cobol_server_3.0_platform -skipsafenet
To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Advanced Installation Tasks (Windows)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.
The advanced installation tasks include:
•
•

Installing as an Upgrade
Command line installation options

Click here to see this information on the Micro Focus Infocenter.
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Installing as an Upgrade
Before installing, check Installation Restrictions and Requirements.
Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.
•

Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

COBOL Server Installation Options
To install COBOL Server you run cs_30.exe which contains a number of product .msi files (Windows
Installer packages). When run, cs_30.exe performs some initial system checks then sequentially installs
the .msi files.
cs_30.exe can take a number of parameters, enabling you to specify a number of different types of
installation:
•

Standard Installation

•

Format:
cs_30.exe
Summary:
Full installation including License Manager and COBOL Server. During installation you can specify
options including the location to which the components are installed.
Non-interactive Installation

•

Format:
cs_30.exe /passive
Summary:
Full installation, but the components are installed non-interactively using default options and
directories.
Silent Installation

•

Format:
cs_30.exe /q
Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.
Modified Silent Installation
Format:
cs_30.exe /q InstallFolder=d:\cobolrts
Summary:
Full installation, but the components are installed non-interactively with no user interface, and
COBOL Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: cs_30.exe /?.
Note:
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•

Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Advanced Installation Tasks (UNIX)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.
The advanced installation tasks include:
•
•
•

Installing as an Upgrade - included in these Release Notes
Command line installation options - included in these Release Notes
Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus
Infocenter

Click here to see this information on the Micro Focus Infocenter.

Installing as an Upgrade
This release works concurrently with the previous version of COBOL Server, so you do not need to
uninstall it.
Install the latest version in a different location and set the environment to point to it. To do this, run the
COBOL Server installer with the –installlocation option:
1. Execute the following command:
./InstallFile -installlocation="/opt/microfocus/VisualCOBOL"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
2. Execute cobsetenv to set the environment and point to the new install location:
. /opt/microfocus/VisualCOBOL/cobsetenv
Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installation Options
Installing into a different location
To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:
./ -installlocation="full path of new location"
Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
You can see details about which additional parameters can be passed to the install script if you enter the help option.
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Configuring Enterprise Server
You can use the following options to configure the Enterprise Server installation: [ ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:
-ESsysLog

Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line for example, -ESadminID="esadm". The default user ID is the one that runs the installer.
-CASrtDir

Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.f
You can use the following command line arguments to install silently on UNIX/Linux:
–silent -IacceptEULA
For example, execute:
[as root] setup_filename –silent -IacceptEULA

After Installing
•
•

See Changes in Behavior or Usage in your product documentation and in the Release Notes for
important information about changes in this release that might affect existing applications.
Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

On Windows
To access the COBOL Server help:
•

On versions of Windows 7 and earlier, select Start > All Programs > Micro Focus COBOL Server >
Documentation from the Windows Taskbar.

•

On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available
links for this product. In the COBOL Server section, click Documentation.

This opens the online Micro Focus Infocenter in a browser. From the left-hand pane, select Micro Focus
Developer > Micro Focus COBOL Server.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
To repair your installation on versions of Windows Vista or later:
1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.
To repair your installation on older versions of Windows, such as Windows XP:
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1.
2.
3.
4.

Click Start Menu > Control Panel > Add/Remove Programs.
Click your Micro Focus product in the list of installed programs.
Click Click here for support information.
Click Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:
1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of
Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add
or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.
When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.
Important: The installer creates separate installations for Micro Focus COBOL Server and Micro
Focus License Administration. Uninstalling only COBOL Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.
To completely remove the product you must uninstall the Micro Focus License Administration as well.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:
start /wait install-file.exe /quiet /uninstall

On UNIX
Setting the Environment
When you have installed the product, you need to set the environment as described below.
1. To set up your product, execute:
. /opt/microfocus/VisualCOBOL/bin/cobsetenv
2. To verify that your product is installed, execute:
cob -V
Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.
To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).
Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.
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Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.
To uninstall this product:
1. Execute as root the Uninstall_COBOLServer3.0.sh script in the $COBDIR/bin directory.
Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.
To uninstall Micro Focus License Administration:
1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.
The script does not remove some of the files as they contain certain system settings or licenses.
You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:
•
•
•

If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.
The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.
For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration
Windows 7 and Earlier

•

From your desktop, click Start > All Programs > Micro Focus
License Manager > License Administration

Windows 8, 8.1, and
Windows Server 2012

•

From the Start screen, click the License Administration tile

Windows 10 and Later

•

Click Start > Micro Focus License Manager > License
Administration

Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a 16digit string of letters and numbers.

If you have a license file
1. Start Micro Focus License Administration.
2. Click the Install tab.
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3. Do one of the following:
•

Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.
4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.
2. Enter the name and location of the license file.

If you have an authorization code
Authorizing your product when you have an Internet connection
Note:
•

It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1.
2.
3.
4.

Start Micro Focus License Administration.
Click the Install tab.
Type the authorization code in the Enter authorization code field.
Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

1.
2.
3.
4.

Start Micro Focus License Administration.
Click Manual Authorization on the Install page.
Make a note of the contents of the Machine ID field. You will need this later.
Do one of the following:
•

40

| Licensing Information

If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

•

If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.
10.Click Install Licenses.

In order to authorize your product you must have the following:
•
•
•

Access to a computer which is connected to the Internet.
Your authorization code (a 16-character alphanumeric string).
The machine ID. To get this, start the Micro Focus License Administration tool and select the Get
Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.
1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.
2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.
3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by
inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:
•
•
•

The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.
The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.
The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Product Support. In the Browse by Product field, click the product you
require support for. Click Log into SupportLine.
Note: Some information may be available only to customers who have maintenance agreements.
If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.
Also, visit:
•

•

The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.
The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.
•
•
•
•
•
•

The name and version number of all products that you think might be causing a problem.
Your computer make and model.
Your operating system version number and details of any networking software you are using.
The amount of memory in your computer.
The relevant page reference or section in the documentation.
Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
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(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.
On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:
•
•

a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.
a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.
To run MFSupportInfo:
1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
a. To create a .log file, click File > Save.
This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.log, in the %temp% directory.
b. To create a .zip archive, click Tools > Create Zip Package.
This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MMSS.zip, in the %temp% directory.
4. Send the diagnostic information to your Micro Focus SupportLine representative:
The following requires an Internet connection and an Email client:
a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.
If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.
On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.
To run mfsupport:
1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.
This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.
Note:
If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.
Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.

Copyright and Disclaimer

| 45

